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Basic Assumptions of This Guide 
Reader has basic Windows and web browser skills. 

Reader has a basic understanding of the EPA Water Quality eXchange (WQX). 

Reader has a basic understanding of Water Quality and WQX terminology.  For a detailed glossary of WQX and AWQMS 

terms, please see the AQWMS User Guide. 

Reader has basic spreadsheet skills such as how to insert new rows and columns, how to move rows and columns of 

data around, how to use basic text manipulation functions, and how to sort rows of data in their spreadsheet. 

This guide uses the AWQMS Demo (awqmsdemo.goldsystems.com) web site and associated demo data files. 

Reader has a decent Internet connection. 

Guide Organization 
This guide is organized in a manner that follows the basic process of using AWQMS to consolidate water quality data and 

submitting it to WQX. This guide does not attempt to cover every aspect of AWQMS nor every scenario.  Where 

appropriate, the guide addresses common, basic “what if” questions that would naturally arise.  The guide also 

references related sections of the AWQMS User Guide where possible. 

This guide presents step-by-step tutorials with corresponding screen shots from AWQMS.  The screen shots have 

numbered arrows that correspond to the numbers of the written steps.  Sometimes there are numbered lists that 

describe what you will see on screen and there will be an associated screen shot with numbered arrows that correspond 

to the numbered items in the written list.  If a numbered step would cause AWQMS to either display a new page or 

refresh the page the user was already on, the guide provides a new screen shot and the numbered steps continue from 

that point. 

Getting Access to AWQMS 
You do not need to download or install software on your computer to use AWQMS.  AWQMS is a web-based database 

application; which means you can interact with the system using a common web browser such as Microsoft Internet 

Explorer, Google Chrome, Apple Safari, or Mozilla Firefox.  All you need is an assigned user name and a password and 

the web site address (also called a “URL”).  The URLs are provided below. 

AWQMS-Demo System – Take a test drive! 
Most, if not all of the exercises in this guide are shown using the AWQMS Demonstration and training system, commonly 

referred to as “AWQMS-Demo”.  If you would like access to AWQMS-Demo (AKA “AWQMS Test Drive”), please send 

email to awqms@goldsystems.com .  The AWQMS Demo web address is:  http://awqmsdemo.goldsystems.com 

AWQMS “Live” Data Systems 

AWQMS-Cloud (Most tribal and volunteer group users) 

Gold Systems also hosts a copy of AWQMS known as “AWQMS-Cloud” for certain customers who wish to avoid the 

hassles and expense of hosting a copy of AWQMS on their own servers.  AWQMS-Cloud holds real data (not demo or 

training data).  The URL for AWQMS-Cloud is:  http://awqms.goldsystems.com . 

http://awqms.goldsystems.com/download/AWQMS%20User%20Guide.pdf
mailto:awqms@goldsystems.com
http://awqmsdemo.goldsystems.com/
http://awqms.goldsystems.com/


AWQMS – Getting Started Guide 

5 
 

If you need a user name and password for accessing AWQMS-Cloud, the Water Quality or Environmental supervisor or 

key AWQMS user for your organization must request access for you by sending an email request to 

awqms@goldsytems.com. 

Deployed AWQMS (Most state users) 

If you work for an organization that hosts its own copy of AWQMS, you should talk to your supervisor or IT department 

about getting access to your organization’s copy of AWQMS.  They should know how to go about getting you a user 

name and password and can provide you the URL for accessing your organization’s copy of AWQMS. 

Logging into AWQMS 
This section describes logging into either the AWQMS-Demo site or the AWQMS live-data system site. The steps are the 

same regardless of whether you are using AWQMS-Demo, AWQMS-Cloud, or a deployed copy of AWQMS. 

1. Open your web browser and enter the web site address for the instance of AWQMS you wish to use into the 

web browser’s address field.  Hit your Enter button or click the browser’s Go button.  In a training situation, that is 

typically:  awqmsdemo.goldsystems.com.  

 

Or, for working with your live data, use AWQMS-Cloud use: awqms.goldsystems.com 

 

For deployed copies of AWQMS, your IT personnel can tell you what the web site address is. 

The AWQMS login screen appears. 

 

2. Regardless of which environment you are using, you enter your AWQMS user name and password into the fields 

on the login form.  Be sure your CapsLk (caps lock) button is not on. 

3. Click the Login button. 

 

If the user name and password you entered are correct, the system will display the AWQMS navigation menu.  If you are 

logged into the AWQMS-Demo environment.  The system will display the navigation menu and the Training 

Environment page. 

 

mailto:awqms@goldsytems.com
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The AWQMS Training Environment Page and the Navigation Menu 
In the AWQMS-Demo environment, the Training Environment page displays links to training resource files that can be 

downloaded.  There is also a Reset button that allows you to clear out any data a previous user of your user name might 

have added or changed and put the account back to a baseline state.  These links and button are not displayed when you 

log into the AWQMS-Cloud environment nor if you log into a deployed copy of AWQMS.   

If you are using the AWQMS-Demo environment, click the Reset button to put AWQMS in a pre-defined, known state. 

 

Here’s what the Home page looks like when you first log into the AWQMS-Cloud environment (no training resources): 

 
 

The drop down menus on the navigation bar will allow you to use the various AWQMS features.  You can hover your 

mouse over a menu item to expand the sub-menu for that item, if there is one.  If you wish to navigate to a feature in a 

submenu, you can click on the item.  Let’s practice some system navigation. 

1. Hover over the Setup menu, then over the Color Scheme submenu, and then click on the Sunset option. 
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If your color scheme wasn’t already set to Sunset, the page will refresh and you’ll see a background and color 

scheme similar to the one shown above. 

 
 

The Help menu on the right end of the Navigation Bar allows you to download various AWQMS guides and 

provides access to a glossary of terms.   

2. Now hover your mouse pointer over the Help menu item and then click on the Getting Started with AWQMS 

item in the drop-down menu.  
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The Getting Started with AWQMS guide downloads to your browser as a .pdf file. 
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3. AWQMS has a Datasets (created by me) menu item that allows you to view a list of datasets you have been 

working with. Hover your mouse pointer over the Review menu item in the Navigation Bar and then click on the 

Datasets (created by me) menu item. 

 
 

The Datasets (created by me) page is displayed.  If you haven’t yet been working any datasets you may see a 

message that says “No records to display”. Otherwise, the list will include the file name, type, and status for any 

datasets you have been working with. 

 
 

4. In AWQMS, you can view a list of links to records you’ve recently been working with and then quickly jump to 

one of those records to continue working.  Hover over the Review menu item in the Navigation Bar and then 

click on the Navigation History menu item. 

 
AWQMS will display the Navigation History page.  If you haven’t done much previously in AWQMS, you may see 

a message that says “No records to display”.  Otherwise the list will provide links to navigate directly to records 

you’ve recently worked with in the system. 



AWQMS – Getting Started Guide 

10 
 

 

 

Key Steps of Using AWQMS 
This is a high level overview of what you do in AWQMS. 

STEP 1:  Lay the Foundation by Adding Your Meta Data 

1a. Enter or import your list of monitoring locations. 

1b. Enter or import your list of projects. 

1c. Enter needed lookup table values. 

STEP 2: Add Your Data to AWQMS 

2a. Enter or import activities and results data into the AWQMS validation area. 

2b. Migrate your data from the 

validation area to the 

management and analysis area.  

STEP 3: Manage and Analyze Your Data 

3a. QA/QC your data using 

reports and graphs. 

3b. Correct errors in your data 

using the management pages. 

STEP 4: Submit Your Data to WQX 

4a. Export and submit your initial 

batch of data to WQX. 

4b. Export and submit on-going changes to your data to WQX. 

There are other things you can do using AWQMS, such as exporting data and planning out your trips.  But this overview 

sums up the basic process. Definitions for terms used in the Key Steps are found in the next sections and in the full User 

Guide. 

Now we will get into more detail for each of the Key Steps. 

A Brief Word about QA/QC Data (Duplicates and Blanks) 

Every activity in WQX and AWQMS must have an activity type.  QA/QC 

duplicate and blank samples should not be included as normal activities.  

Rather, they should be included using the special QA/QC activity types 

defined in the Activity Type lookup tables.  This will allow you to filter 

them out, if desired, when analyzing/reporting on the data. 

Note that using a different activity type causes the activity ID for the 

QA/QC samples to be different than for the normal samples, assuming 

you are following the activity ID format suggested in this guide. 

See Appendix D, below for more considerations regarding QA/QC 

samples. 
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STEP 1: Lay the Foundation by Adding Your Meta Data 

1a. Enter or import your list of monitoring locations 
Monitoring Locations are records that represent the physical site where you took a sample or made an observation.  A 

unique ID, a name, the coordinates for the location, horizontal reference datum, and horizontal collection method are 

all required data elements. 

How can I tell if I already have monitoring locations in AWQMS? 

1. Hover your mouse cursor over Metadata then click on the Monitoring Locations menu option. 

 
The system will display two tabs: Search Criteria and Monitoring Locations.  The Search Criteria tab allows you 

to specify search criteria to filter for the list of Monitoring Locations.  The Monitoring Locations tab allows you to 

see a list of Monitoring Locations that match the search criteria you specify.  Note; the buttons above the tabs.  

They are always visible/accessible when you are in this Monitoring Locations list page. 

2. Select your organization ID from the Organization ID drop-down list.  

 
3. Click the Search button.  

The system will display a list of Monitoring Locations you already have in the system.  If there are none, the 

system will display a message stating so. 
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What should I do if I don’t have any monitoring locations in AWQMS or if some of my locations aren’t in 

AWQMS yet? 

If you are missing monitoring locations in AWQMS, you can easily add them manually using the Monitoring Location 

detail page.  You can also import a list of monitoring locations. 

If you only have a few monitoring locations that are not yet in AWQMS… 

If you have fewer than, say, 12 monitoring locations, we recommend manually entering them into AWQMS under the 

Meta-Data. 

Step by Step Tutorial: manually entering Monitoring Locations. 

1. Hover on the Metadata --> Click on Monitoring Locations. 

 

 

 

2. Verify that the location you want to add is not already in the list by searching through your organization’s 

locations. 

 

 

 

 

Monitoring location identifiers and names 

should be managed carefully to prevent 

accidental creation of multiple location 

records for the same real-world location.  

Also, if monitoring location IDs and/or 

names are modified after-the-fact in 

AWQMS, be aware that all the historical 

activities and results associated with the 

location record will be associated with the 

new ID or name and not with the old ID or 

name.  Be sure to document changes 

made to the IDs or names so that you or 

others will understand why/how the IDs 

and/or names changed. 
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3. Let’s assume the location you wish to add is not there.  Click the Add New button at the top of the list page. 

 

 

A blank Monitoring Location Detail form will be displayed. 

 

 

Required fields are denoted with 

an asterisk (*). For each monitoring 

location, you will need to enter 

the: org ID, monitoring location ID, 

monitoring location name, lat/long, 

datum; horizontal collection 

method.  

Lat/longs: EPA recommends using 

at least 5 decimal degrees (e.g., 

48.17305 is 5 decimal degrees) for 

lat/longs to improve the accuracy 

of the sampling location. Mapping 

sampling locations helps identify 

sites with incorrect or inaccurate 

lat/longs. 
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4. (See callouts A through H) Fill in at least the required fields on  

the form.  Required fields are denoted with an asterisk (“*”)  

character in the label.  

5. Click the Save button at the top of the form. 

The system will indicate whether a new location record  

saved successfully.  If there are issues with the record,  

either an error message or a warning will be displayed.  

 
In this example, we needed to fill in the Geospatial section at 

the bottom of the form with valid coordinates and a Horizontal 

Reference Datum and Horizontal Collection Method.   

(We used Latitude: 48.06523, Longitude: -106.40259, 

NAD83, GPS Unspecified). 

 

 

 

 

 

 

 

 

 

6. Resolve any errors you might have in your form and then click the Return button at the top of the page to return 

to the Monitoring Location list page. 

NOTE: Because the Monitoring Location ID is 

often used as the first segment of an Activity 

ID, it is advisable to keep Monitoring Location 

IDs relatively short.  The Activity ID field is 

restricted to just 35 characters and often must 

also include date, time, depth, and activity 

type information to make it unique.  

Therefore, we recommend keeping your 

Monitoring Locations to a maximum of 6 

characters.  For example, if the Monitoring 

Location name is “Rio Piedras 05” then the ID 

could be “RP05”.   The details such as “5 feet 

north of the foot bridge” can be stored in the 

Description field. 

EPA encourages tribes to use 

monitoring location IDs reflective 

of their sampling location instead 

of generic acronyms. For example, 

instead of using ML01 and ML02 to 

describe sampling sites on the 

Aquamarine River and Diamond 

River, the tribe could call ML01 = 

Aquamarine01; Diamond01. This 

type of monitoring ID helps 

someone less familiar with the 

sampling locations to understand 

the monitoring design. 
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If you have a lot of monitoring locations that are not yet in AWQMS… 

If you have more than approximately 12 monitoring locations that are not yet in AWQMS, you can import a text file of 

location records under Import.  This approach may be faster than entering each one manually.  When you import a file 

of locations, the imported data becomes an “import dataset”.  (See the AWQMS User Guide section on WORKING WITH 

IMPORT DATASETS). 

The AWQMS-Demo site has an example file on the Training Environment page that you can download and import into 

AWQMS-Demo.  However, if you are using either AWQMS-Cloud or a deployed copy of AWQMS, you’d use your own file 

of actual locations.  To download the demo file to your machine, hover over the Setup menu item, click on the Training 

Resource Files sub-menu item, then click on the Monitoring Locations.xlsx link.  Be sure to remember where the file has 

been saved.  It may be in your browser’s downloads folder. 

Step by Step Tutorial: import a file of Monitoring Locations. 

1. Hover on the Import then click on import Monitoring Locations, Assessment Unit & Reaches. 
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The Import a File (Choose File) page will be displayed. 

 
 

2. Indicate which Import Configuration you will be using to import the file.  For the demo file, choose the option 

that has the words Demo User <##> ~ Monitoring Locations ~.  Also, select the type of file (.xlsx). 

3. Click the Choose File button and browse to and select the Monitoring Locations.xlsx training file you 

downloaded.  

4. Click the Import Data button at the top to begin importing your file. 

 

5. The system will display the Dataset Summary page.  The page will display a message stating that it is importing 

the file. 

When working with files 

of data, (as opposed to 

data in a database), we 

suggest manipulating 

data in a spreadsheet file 

(Microsoft Excel) 

because it will keep the 

formatting changes you 

make in the file to make 

it more readable.  

Because AWQMS 5.0 

now allows you to 

import directly from an 

Excel file, there is no 

longer any need to save 

the data as a comma or 

tab-delimited text file.   
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If all goes well, the Dataset Summary page will refresh and indicate that it has completed importing the file. 

The Status will say Imported (highlighted in yellow in the image).  The page will indicate that five locations were 

imported and that, of those five locations, zero were invalid, five were new, and zero were existing. 

6. Click the Migrate button.  

The system will indicate that the data is being migrated from 

the AWQMS staging area to the AWQMS management area.  

NOTE: Migrating an import dataset in AWQMS is NOT the 

same as submitting data to WQX!   

If all goes well, the Dataset Summary page will refresh and 

indicate that the locations migrated into AWQMS 

successfully.  The status of the dataset will say Migrated 

(highlighted in yellow, below).  

You can choose to “Auto Migrate” 

your datasets that have no 

errors/warnings in your User 

Preferences 

Setup-> My User Preferences -> 
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7. Click the Return button. 

 

You could now go to the Monitoring Locations list page and search for the new locations you imported. 

 

What if things don’t go well?  How do I fix import errors? 

As a matter of fact, things rarely go perfectly the first time you try to import a file; and the process of importing data 

into AWQMS tends to be iterative and might involve a little “trial and error.”  If the system displays error messages 

during an import or shows that your import data set has a status of “Failed” there is no need to panic.  You still have 

your import file and can always try importing it again.  Here are some general guidelines for resolving errors when 

importing data files into AWQMS: 

 If the problem is an import configuration-to-import file mismatch error, such as the columns in your spreadsheet 

not matching up with the columns “mapped” in your import configuration, you will need to either adjust the 

import configuration, the import file, or both and then attempt to re-import the data.  It is best to fix these types 

of errors first, because they require you to re-import the file.  Once these types of errors are addressed, you can 

address four other typical types of errors within the system without having to re-import the file. 

 If the problem is that a required value was missing from your file, the system will provide a link to a page that 

allows you to provide the missing value without having to re-import the file. 

 If the problem is that your file contains values for a data element that are not in the list of acceptable values for 

that data element, the system will provide a link to a page that allows you to provide the correct value without 

having to re-import the file. 

 If the problem is that your file contains data values for a data element that don’t match the expected format, 

(such as a date format), the system will provide a link to a page that allows you to specify the format your data 

values are in. 

If you get an error, take note of 

what the error message says.  If 

you are contacting another person 

for assistance, you should copy the 

error message to an email message 

or copy an image of the page to an 

email message. Take note of when 

the error occurred such as “After I 

clicked on the Continue button.”  

Provide both the file to be 

imported and the ID number of the 

import configuration you are using 

to anyone from whom you are 

requesting assistance. 
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 If the problem is that your file contains data values that are too long to fit into the matching AWQMS/WQX data 

elements, the system will provide a link to a page that allows you to change the data so that it will fit into the 

AWQMS/WQX data element. 

See the AWQMS User Guide section, working with Input Datasets, for more information on resolving validation 

errors in a dataset. 

Location Import Configuration – Do I have one and what should I do if I don’t? 

In the exercise above, we assumed you already have an import configuration for importing your list of locations.  We 

used the import configuration for monitoring locations that is built into the AWQMS-Demo environment.  In AWQMS 5.0 

every user of the system has read-only access to at least one system-owned import configuration for Monitoring 

Locations.   The system-owned import configuration for monitoring locations matches the output format of the 

Monitoring Locations export file that is generated when you export from the Monitoring Locations List page.  You can 

make a copy of that import configuration and tweak it as needed.  This is a very simple way to get started.  You can also 

do one of the following to get one: 

1. Ask someone who already has one (such as Gold Systems or a co-worker) to share theirs with you (give you 

rights to view or even edit theirs).  The AWQMS user guide has instructions on how to share an import 

configuration with someone else.  Just do a search on Rights on an Import Configuration in the AWQMS User 

Guide.  Once you have access to someone else’s import configuration, you can just make a copy of theirs and 

“tweak” it to meet your needs.  Frankly, monitoring location import files are typically quite simple and it may 

actually be easier to just modify your file to match whatever import configuration you have access to. 

2. Save the demo import configuration from the demo environment as a file and then create a new import 

configuration in your live AWQMS account based on the saved file.  From the Demo environment, you just click 

the Save to File button at the bottom of the import configuration detail page.  Then in your live account, you 

create a new import configuration by importing a saved file.  (Search for Create an import configuration from a 

saved file in the AWQMS user guide). 

3. Build your own from scratch.  (Search for Creating a New Import Configuration in the AWQMS user guide). 

4. Download the WQX Web template from the EPA WQX Web Downloads web site and import the monitoring 

locations template import configuration.  This is not worth explaining in this context; especially when there are 

much easier methods.  However, it is essentially similar in concept to #2, above.  The EPA has created some 

import configurations and saved them as files that you can download and the use as the basis for a new one in 

AWQMS.  There are links to the EPA template at the AWQMS portal documentation / tutorials page. 

  

http://www.awqms.com/node/2
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1b. Enter or Import Your List of Projects 
Each organization must have at least one project in AWQMS because every activity recorded in AWQMS must be 

associated with at least one project.  Your organization may wish to have more than one project so that you can search, 

sort, or filter your activities by project.  Examples of projects might include “Annual 106 Monitoring” or “2013 Summer 

Special Nutrient Study”. 

Do I already have projects in AWQMS? 

1. Hover over the Metadata menu item in the Navigation Bar and click on Projects. 

 
 

The system will display the Projects list page.  The first tab on 

the page allows you to filter the Project list by adding search 

criteria in the fields and clicking the Search button. 

2. Make sure your organization ID is in the Organization ID field. 

 

 

3. Click the Search button. 

The system will flip to the Projects tab and display a list of Projects you already have in the system.  If there are 

none, the system will display a message stating so. 

 

 

 

Most EPA Region 8 tribes with 106 

programs probably already have 

existing projects in AWQMS. 
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4. Click on the project ID links to view or edit the details of a project. 

 
The system will display the Project Detail page.   

 

**Note: The Return button saves your changes since the last save and returns you to the Projects list page.  The 

Save button saves your changes since the last save and keeps you on the Project Detail page.  The Cancel button 

returns you to the Projects list page but does not save your changes since the last save** 

 
5. Click the Cancel button. 

The Projects list page will be displayed with either the Search Criteria tab or the Projects tab displayed. 
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What should I do if I don’t have any projects in AWQMS or if some of my projects aren’t in AWQMS yet? 

If you are missing projects in AWQMS, you can easily add them manually using the Project detail page.  You can also 

import a list of Projects. 

If you have a small number of projects that are not yet in AWQMS… 

If you have fewer than 10 projects, we recommend manually entering them into AWQMS. 

Step by Step Tutorial: manually entering Projects. 

1. Hover over the Metadata, Click on the Projects menu item. 

 

The Projects List Page will be displayed with a Search Criteria tab and a Projects tab.  Note: You may not see 

every project shown in the image below. 

2. Verify that the project you want to add is not already in the list.  

 (Do a search through your organization’s projects.) 

 
3. If you are sure the project you wish to add is not already in the list, click the Add New button at the top of the 

page. 

A blank Project Detail form will be displayed. 

4. Fill in at least the required fields on the form.  Required fields are denoted with an asterisk (“*”) character in the 

label.  

5. Click the Save button at the top of the form. 
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The system will indicate whether the new project record saved 

successfully.   

 

If there are issues with the record, either an error message or a warning will be displayed.  For example, this 

error message is telling us that we mistakenly re-used the same project ID as one that has already been used. 

For this exercise use create the 

following Project: 

Project ID: 

PurpleTributariesSpecialProject 

 

Project Name: 

Purple Tributaries Special Project 

 

Description:  

Special study of the Purple 

Tributaries. 

 

Sampling Design Type: 

Probabalistic 

 

QAPP Approved: Yes 

 

Approval Agency: US EPA 
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6. Once any errors have been resolved, click the Return button at the top of the page to return to the Projects list 

page.   

 

The projects list page will be displayed with either the Search Criteria tab or the Projects tab displayed.  Note: if 

the Search Criteria tab is displayed, click the Search button and you’ll see your new project in the list. 
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1c: Enter your lookup table values 

What are lookup tables? 

Sometimes a data element in AWQMS can only have a value from a specified 

list of choices; called a Domain Value List (DVL).  Sometimes these lists are 

called pick lists or lookup tables.  If your data contains values for a 

WQX/AWQMS data element that is constrained by a lookup table, your value 

must either match a value already in the lookup table or the data value has to 

be added to the lookup table as one of the allowed values.  Otherwise, the 

record won’t be allowed into AWQMS and WQX. 

Some lookup tables might be completely under your control.  These are 

called Internal Tables.  Other Tables might be under EPA’s control.  These are 

called EPA Managed Tables.  Other times, part of the list might be under EPA control while part of the list might be 

under your control (known as a hybrid table). 

You view and manage lookup tables under Metadata.  Before reviewing the 

lookup tables, we recommend having the following documentation available: 

lab reports, QAPP, tribal water quality standards or EPA criteria, SOPs or field 

manuals. For the purposes of this tutorial, the following lookup tables are 

important to fill out before going further: 

 Sample Collection Methods – These are referenced by the activities you 

wish to enter or import into the system. 

 Sample Preparation Methods – These are referenced by the activities 

you wish to enter or import into the system. 

 Analytical Methods (where your method isn't already available in the 

US EPA or other standard method "context" tables) - These are referenced by 

the sample results you wish to enter or import into the system. 

 Sample Preservation Methods – required under certain conditions. 

 Thresholds– These are referenced when you import or enter data - the 

system validates data against the thresholds as the data is imported/entered 

into the system. 

 

Do I already have values in my lookup tables? 

You can see what values are stored in your lookup tables in AWQMS.  The step by step guide below uses sample 

collection methods as an example; but you can use the same steps to view the values in any of the lookup tables. 

  

We recommend 

reviewing lookup table 

values at least annually.  

Be sure any changes to 

analytical methods, etc. 

are reflected in the 

lookup table values. 

All organizations using 

AWQMS have access to 

reference the lookup tables.  

However, only the 

administrative user(s) for an 

organization has privileges to 

modify the allowed values in 

the internal and hybrid 

lookup tables.  AWQMS users 

do not have privileges to 

change, add to, or remove the 

values in the EPA Managed 

lookup tables. 
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1. From the navigation bar Hover on Metadata. 

 
2. Click on the Sample Collection Method.  The Sample Collection Methods lookup table will be displayed.   

 
 

3. After reviewing the list of methods in the lookup table, click the Cancel button to return to the Lookup Tables 

page without saving any changes. 

 

What should I do if I’m missing lookup values? 

If you are missing lookup values for tables in the Internal Tables, you can easily add them to AWQMS yourself for your 

own organization’s needs.  Check with your EPA water quality lead or Gold Systems if you have questions. 

If you are missing values for tables in the Hybrid Tables, you could add the missing values yourself for only your own 

organization.  However, if the missing value is a value that you think other organizations will need, (e.g. an EPA 

Analytical Method), then you should send an email to storet@epa.gov and ask the WQX/STORET help desk to add the 

value to the lookup table under the appropriate “context” (e.g. “EPA”) for everybody’s use.  Please CC 

awqms@goldsystems.com when you send such requests to storet@epa.gov. 

mailto:storet@epa.gov
mailto:awqms@goldsystems.com
mailto:storet@epa.gov
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If you are missing values for tables in the EPA Managed Tables, you should send an email to storet@epa.gov and ask the 

WQX/STORET help desk to add the value to the lookup table under the appropriate “context” (e.g. “EPA”) for 

everybody’s use.  Please CC awqms@goldsystems.com when you send such requests to storet@epa.gov. 

Adding Sample Collection Methods 

Sample Collection Method ID and a related Context (Method Source) is required information for any activity that has an 

Activity Type that contains the word Sample.  The Context is almost always going to be your Organization ID.  If possible, 

list actual methods your organization uses, rather than just ‘QAPP’ since ‘QAPP’ is not very descriptive.  Fill in as many of 

the data elements as you can so that the data will be meaningful. 

1. Follow steps 1 and 2 from the previous exercise to get to the Sample Collection Method lookup table page.  

The Sample Collection Methods lookup table will be displayed.  The column headers with asterisks (“*”) denoted 

fields that are required and must be filled in. 

Note: Most people have access to only one organization and it will automatically be selected in the 

“Organization” field at the upper left of the form.  However, if you have access to more than one organization, 

you may need to choose the organization for which you wish to view Sample Collection Methods. 

2. Click the Add New bottom at the top of the page and a blank row will appear for you to fill in accordingly. Fill in 

the Sample Collection Method ID.  Make sure you enter an ID that has not already been used for this 

organization.  Enter the Context.  You can think of the context as the “source” of the method.  For example, it 

may be a home-grown method developed by your own organization.  In that case, you would enter your own 

organization name or ID as the context.  Enter the name of the method (not your own name and not the name 

of the organization).  Leave the Qualifier Type field blank 

unless you have information that you already know 

should be added there.  Add a description of the method.  

Some people type a full description while others enter a 

simple reference to an external document. 

 

3. Click the Save button.  

The system will refresh the Sample Collection Methods Lookup Table page and you will see your new sample 

collection method in the list with a blank row at the bottom of the list.  If there were no errors, there will be a 

message at the top of the page stating that the item was saved successfully.  If there were issues with the 

attempt to save the new method, there will be one or more warnings and/or error messages displayed at the 

top of the page. 

For this exercise you can use the following 

values: 

ID:  MyCollectionMethod 

Context:  DemoOrg 

Name:  My Collection Method 

Description:   Dip it.  Dip it good. 

mailto:storet@epa.gov
mailto:awqms@goldsystems.com
mailto:storet@epa.gov
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(You can repeat steps 3 and 4 for as many methods as are 

needed). 

4. Click the Return button at the top of the page to return to the 

Lookup Tables page. 

 

 

Adding Sample Preparation Methods to the Lookup Tables 

Adding sample preparation methods to the lookup tables is very similar to adding sample collection methods to the 

sample collection methods lookup table.  The only real difference is that you would choose Sample Preparation Method 

from the Lookup Tables page (or from the Metadata menu).  Here’s what they looked like when we added ours.  In the 

AWQMS-Demo environment, yours should look the same.   

 

Adding Analytical Methods 

A note on adding Sample Preservation Methods 
as Sample Preparation Methods 
If you identify a sample preparation method for an 
activity, WQX requires you to either provide a 
chemical preservation method or a thermal 
preservation method (or you can provide both).  You 
also have to report container type and color as well as 
a description of how the sample is handled and 
transported.   

For your Sample Preparation Methods lookup table, 
you may want to think through the set of Sample 
Preparation Methods that you use and add a 
corresponding Preservation Method name and 
identifier for each (i.e. EPA2014-METALS).  
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When you are entering or importing results from a lab, WQX needs the Analytical Methods that were used to derive the 

result values.  Any Analytical Methods referenced in your data have to exist in the AWQMS Analytical Methods lookup 

table before the results data can be brought into the system.  Therefore, from time to time you may need to add an 

analytical method to the lookup table.  

 

Before adding new Analytical Methods under your own “context” (organization), you should follow the steps above 

under “Do I already have values in my lookup tables” and be sure the analytical method you wish to add isn’t already 

available under one of the contexts such as “US EPA”, “HACH”, “APHA”, etc.  Once you are confident that the desired 

analytical method is not already available, you can add it to your own organization’s context using the following steps. 

1. Hover on the Metadata and click on Analytical Methods.  

 

 
 

 

The Analytical Methods table page will be displayed, but no 

list will show until you’ve selected the context. 

 

 

 

Most of the time, labs use standard 

methods from the EPA or the 

manufacturer of a kit or piece of 

lab equipment.  You should rarely 

have to add analytical methods in 

your own lookup table; but you 

may have to ask your lab to 

provide the “context” of the 

methods they use. 
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1. Select your “context” (your organization) from the drop-down list.  

 

The list of analytical methods for your “context” (your organization) will be displayed.  (These are just examples 

we copied into your demo account).  There will be a blank row for adding a new method at the bottom of the 

list.  Column headers with asterisks (“*”) denote required fields that must be filled in. 

 

2. Click on Add New at the top of the page. A blank row will appear.  Fill in at least the required fields.  

For this exercise you could use the following fake data: 

ID: MyAnalyticalMethod 

Name: My Analytical Method 

Description: Method for analyzing my samples. 

 
3. Click the Save button.   

 

The page will refresh and there will be a message at the top of the form indicating that the data saved 

successfully.  If there were any problems when attempting to save the new data, the system will display 

warnings or error messages. 

 

 
 

Repeat steps 2 and 3 as many times as needed. 

 

4. Click the Return at the top of page. 
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Adding QA/QC validation thresholds 

You should add QA/QC Thresholds to your lookup tables before importing activity and result data because the system 

can’t check whether your result values are within a reasonable range without these in place.  Also, the system can’t 

check for consistency in the combinations of characteristic name, unit of measure, sample fraction, and method 

speciation until you have added the list of thresholds to your lookup tables.  For the rest of this tutorial, we will refer to 

a characteristic name, unit of measure, sample fraction, and method speciation combination simply as an analyze. 

1. Hover on Metadata on the navigation bar, you’ll get a drop down menu. 

 
2. Click on the Thresholds (for exceedance checking or quality control) menu item. 

The Lookup Table Threshold page will be displayed; but there will be no data showing.  There are four tabs.  

One for Threshold Group Criteria, one for Result Thresholds, one for Metric Thresholds, and one for Index 

Thresholds.  In this example, we will only be working with the second tab, Result Thresholds, but do not click on 

it yet. 

3. While on the Threshold Group Criteria tab, select your organization from the Organization drop-down list. 

4. In the Threshold Type drop-down list, select Quality Control. 
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Note: There is a “Designated Use” field below the “Type” field.  When you select “Quality Control” from the type 

list, the “Designated Use” field disappears because it is not applicable for Result Validation (QA/QC) type 

thresholds.  

 
5. Click the Search button.   The page will refresh but the Results Thresholds tab will be displayed. 

If you have entered result validation thresholds for your organization previously, they will be displayed in the list 

on the Result Thresholds tab.  If you have not yet entered result validation thresholds, there will be a single 

empty row in the list.   

 

This list is intended to represent every parameter that you expect will be imported or entered into the system.  

Additionally, the list is intended to document the upper and lower bounds for what you consider to be 

reasonable measurement values for each parameter.  There are no columns denoted as required fields but each 

row must have, at a minimum, the characteristic and the unit of measure specified. 

 

You could add each parameter (combination of characteristic name, unit of measure, sample fraction, and 

method speciation) one-by-one by filling out the blank row and clicking save, and so on.  But that is a lot of 

work, so for this example, we are going to use a shortcut to create our parameters based on results data we 

already have in the system. 

6. Rather than filling out the blank row, click on the Generate Thresholds button.   

 
A dialog box will pop up asking you whether to proceed with generating the rows. 
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7. For this exercise, keep the default settings and click the OK button. 

 

The page will refresh and there will now be one row in the Result 

Thresholds tab for each distinct parameter in your organization’s 

data. 

Note: the Lower and Upper columns allow you to enter lower and 

upper threshold values, as appropriate, for each distinct parameter.  

These lower and upper threshold values define the reasonable range 

of expected result values for the parameter.  

If you leave the lower value empty, you are telling the system that any value 

below the upper value is OK. 

If you leave the upper value empty, you are telling the system that any value above the lower value is OK. 

8. Enter your lower and upper values as follows. 

Dissolved Oxygen (mg/l) – Lower = 1 Upper = 10. 

Nitrogen Total mg/l Upper = 5 

pH None Lower = 4, Upper = 11 

Phosphorus ppm Upper = 1 

Temperature, water deg C Lower = 1 Upper = 35 

Turbidity NTU Upper = 300 

 

9. Click the Save button.  

 

The system will refresh the Thresholds Lookup Table page and you will see your parameter threshold list with a blank 

row labeled “{none}” at the bottom of the list.  If there were no errors, there will be a message at the top of the page 

stating that the save was successful.  If there were issues with the attempt to save the new index type, there will be 

one or more warnings and/or error messages displayed at the top of the page. 

Note: Appendix C contains 

recommended QA/QC 

Threshold values for EPA 

Region 8 Tribes who don’t 

already have more specific 

QA/QC Thresholds.  Tribes in 

other regions may want to 

work with EPA in their locale to 

decide on QA/QC Thresholds 

specific to your area. 
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10. Click on the {none} link on the bottom row to add another characteristic to the list. 

A characteristic search form will pop open. 

 

11. Type Ammonia 

12. Click the Search button. 

 
A list of characteristic names containing the word, ammonia will be displayed. 

 

13. Select Ammonia from the list. 

 
The list will close and Ammonia will be displayed as the new Characteristic in the new row in the list. 

 

14. Fill in the Unit field with mg/l and the Upper Threshold field with a value of 2. 

15. Click the Save button at the top of the page to return to the Lookup Tables page. 
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Your updates have been saved successfully 

 
16. Now that you have created Quality Control thresholds in your lookup tables, you can tell the system to check 

your results data against the thresholds whenever you import or manually enter data.  In the Navigation menu 

click on Setup  Organization Preferences. 

 
A list of organizations to which you have access will be displayed. 

17. Select the organization for which you wish to apply your Quality Control thresholds. 

 
The Organization Preferences page will be displayed. 

 

18. Click on the drop-down list box and select the Quality Control threshold group we just created.  Then select the 

validation type of All of the Above.  The All of the Above Validation Type will both verify that each imported or 

entered result’s characteristic, sample fraction, unit of measure, and method speciation combination exist in the 

threshold lookup table and verify that the result value is within the range specified in your threshold lookup 

table. 
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Select the first radio button under Consequence (when 

validation fails): which is labeled “ Warning: Log a warning, 

but allow the result to be saved”.  This choice allows the data 

to be saved in the system, but displays a warning to alert you 

to the fact that either a result value is outside the expected 

range or that the result value is for an unexpected 

combination of Characteristic, Unit of Measure, Sample 

Fraction, and Method Speciation. 

19. Click on the radio button under Data Publishing this will flag 

data as ‘public’ as soon as it is saved (unless its status is 

Preliminary or Rejected). NOTE: This option is probably 

already selected by default. 

20. Click on the Return button to save your choices and return to the list of organizations.  

Clicking the Return button saves 

your changes before leaving the 

page you are on and returning you 

to the previous page.  Clicking the 

Save button saves your changes 

and keeps you on the same page. 
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STEP 2: Import or enter activities and results data into the AWQMS validation area 

and then migrate the data to the management area 

If your data is in electronic files… 
For any data you have in electronic spreadsheet or text files (NOT .pdf files) the goal should be to import that data into 

AWQMS so you don't have to enter it manually.  You can think of it as three steps: 

1. Create an Activities and Results import configuration to match your file.  This is how you tell AWQMS how to 

read your file.  As long as you continue to use the same file format for future data, you can continue to use the 

same import configuration. 

2. Import the file of data into AWQMS using the Import -> Activities & Results menu item 

3. After successfully importing your file and resolving any validation errors, you then migrate the files into the 

AWQMS management and analysis area. 

We’ll go into more detail in the following sections. 

Activities and Results Import Configuration – Do I have one and what should I do if I don’t? 

You should have at least one Activities and Results import configuration for each type of data (chemistry, 

macroinvertebrate, field data, etc.) that you intend to import into AWQMS.  In the exercise below, we use the import 

configuration for field measurement data that is built into AWQMS-Demo.  Every AWQMS user has read only access to 

at least one system-owned Activities and Results-type import configuration.  If you don’t already have an import 

configuration for importing field measurements or any other Activities and Results type data, you can copy the system-

owned one and use that as a good starting point.  You can also do one of the following to get an Activities and Results-

type import configuration: 

1. You can ask someone who already has one (such as a co-worker, another consortium member, Gold Systems, or 

maybe a regional EPA water quality lead) to share theirs with you (give you rights to view or even edit theirs).    

The AWQMS user guide has instructions on how to share an import configuration with someone else.  Just do a 

search on Rights on an Import Configuration in the AWQMS User Guide.  Once you have Read access to 

someone else’s import configuration, you can just make a copy of theirs and “tweak” it to meet your needs.    

2. You can save the demo import configuration from the demo environment as a file and then create a new import 

configuration in your live AWQMS account based on the saved file.  From the Demo environment, you just click 

the Save to File button at the bottom of the import configuration detail page.  Then in your live account, you 

create a new import configuration by importing a saved file.  (Search for Create an import configuration from a 

saved file in the AWQMS user guide). 

3. You can build your own from scratch.  (Search for Creating a New Import Configuration in the AWQMS user 

guide). 

4. You can download the WQX Web template from the EPA WQX Web Downloads web site and import the 

Activities and Results template import configuration.  This is not worth explaining in this context; especially 

when there are much easier methods.  However, it is essentially similar in concept to #2, above.  The EPA has 

created some import configurations and saved them as files that you can download and the use as the basis for 

a new import configuration in AWQMS.  There are links to the EPA template at the AWQMS portal 

documentation / tutorials page. 

  

http://www.awqms.com/node/2
http://www.awqms.com/node/2
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The AWQMS-Demo site has some example files on the Training Environment page that you can download and import 

into AWQMS-Demo.  However, if you are using either AWQMS-Cloud or a deployed copy of AWQMS, you’d use your 

own file of actual Activities and Results.  To download the demo file to your machine, hover over the Setup menu item, 

click on the Training Resource Files sub-menu item, then click on the Activities and Results – no errors.xlsx link.  Be sure 

to remember where the file has been saved.  It may be in your browser’s downloads folder. 

Example: Importing Field Measurement Activities and Results 

Step by Step Tutorial 

1. Hover over Import from the navigation bar, click on Results & 

Activities.  

 

2. The Import File page will be displayed. 

 
 

3. Fill in the Import File form to specify which file to import and how to import it.  First you’ll specify the import 

configuration to use when importing the file and then the type of file to be imported. 

For this demo exercise choose your demo user’s Activity and Results import configuration and Microsoft Excel 

(xlsx).  The page will refresh and show additional fields. 

 

Leave the sheet to be imported as the 1st sheet.  Leave the checkbox for ignoring the first row of the file 

checked.  Leave the Organization ID to be automatically generated/supplied for each row of data as your demo 

organization.  Specify whether you expect your file to contain new or existing data (for this demo, choose This 

file contains new data only). 

Find and select the file you wish to import.   

Note: Be sure to make the activity 

IDs in your file unique, such as a 

combination of the location ID, the 

date, the time, and the type of 

activity.  If you use activity IDs that 

have been used previously, AWQMS 

and WQX will both assume you wish 

to update the existing activities with 

modified information and will also 

delete the existing result records for 

the existing activities and replace 

them with the new results you are 

importing.  In other words, if you 

don’t use unique activity IDs, you 

may accidentally overwrite existing 

data with new data! 
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4. Click the Import Data button. 

 

5. The Dataset Summary page will then begin the import. The page will automatically refresh approximately every 

10 seconds.  For larger uploads, the refresh will occur every 60 seconds after the first minute. 

 
If all goes well, the system will eventually indicate that the import has completed.  There will be a box in yellow 

stating your Dataset is ready to be migrated.  The system will show how many activities, activity groups, and 

results were imported, under Imported Records.  It will also display a message box – if there are no errors or 

warnings, it will just display messages.  
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6. Click the Migrate button. 

The dataset summary page will again refresh and indicate that the system is migrating the data from the 

AWQMS staging area into the AWQMS data management area. 

 

If all goes well, the Dataset Summary page will refresh and indicate that the activities, results, and activity 

groups migrated successfully! 

7. Click the Return button to return to Home page. 

 

My Datasets page will be displayed; this shows what dataset you have been currently working on. 

You could now go to Review  Activities and search for the new Activities you imported. 

What if the system gives me errors during the import process? 

AWQMS checks your data against numerous WQX rules.  If the data violates any of these rules, the system logs error 

messages and/or warnings.   The Dataset Summary page will display a list of the types of errors.  For several of the more 
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common types of errors, there will be links on the Dataset Summary page that allow you to resolve the errors right in 

AWQMS without having to fix and reimport the data in the file. 

If you would like to try this out, download and import the “Activities and Results - errors to fix after import.csv” file on 

the awqmsdemo.com website.  This file is intentionally designed to cause various types of errors to occur. 

See section “What if things don’t go well?  How do I fix import errors?”, above.  Note that you should typically resolve all 

of the errors in a dataset before migrating the data from the AWQMS staging area into the AWQMS management and 

analysis area. 

If your data is on paper… 
For any data you do not have in electronic spreadsheet or text files, the goal should be to enter the data manually 

directly into the AWQMS management and analysis area (and not into an intermediate file or spreadsheet). You do this 

via Data Entry pages in AWQMS.  If configured optimally, data entry pages can save time and reduce data entry errors.   

You can think of it as a two-step process: 

1. Configure a Data Entry page to meet your data entry needs. 

2. After your data entry page(s) is/are configured, use the Enter -> Results and Activities link to choose your page 

and then begin entering Results data one activity at a time.  

Data Entry Page Configuration – Do I have one and what should I do if I don’t? 

The steps below assume you are using the data entry page that is pre-configured in the AWQMS Demo environment.  

Note, however, that you can configure as many different data entry pages as you need.  For example, the demo 

environment has one configured for fish counts and another configured for field measurements.  There’s also a system-

owned Data Entry Page Configuration specifically for entering bacteria tray count values if you use the Quanti-Tray 

2000 bacteria analysis kit.  If you don’t already have a data entry configuration for entering field measurements or any 

other Activities and Results type data, you can do one of the following to get one: 

1. Ask someone who already has one (such as a co-worker, another consortium member, Gold Systems, or maybe 

a regional EPA water quality lead) to share theirs with you 

(give you rights to view or even edit theirs).  This is, by far, 

the easiest method!  Sharing a data entry configuration 

works just like sharing an import configuration in AWQMS.  

The AWQMS user guide has instructions on how to share an 

import configuration with someone else.  Just do a search 

on Rights on an Import Configuration in the AWQMS User 

Guide.  Once you have access to someone else’s data entry 

configuration, you can just make a copy of theirs and 

“tweak” it to meet your needs.    

2. Save the demo data entry configuration from the demo environment as a file and then create a new import 

configuration in your live AWQMS account based on the saved file.  From the Demo environment, you just click 

the Save to File button at the bottom of the rapid entry configuration detail page.  Then in your live account, 

you create a new import configuration by importing a saved file.  (Search for Create an import configuration 

from a saved file in the AWQMS user guide). 

Data Entry pages enforce any 

QA/QC validation thresholds you 

have set up in your Threshold 

lookup table. 
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3. Build your own from scratch.  (Building a new rapid entry configuration is very similar to building a new import 

configuration.  Search for Creating a New Import Configuration in the AWQMS user guide). 

Entering Field Measurements via Data Entry 

1. Hover on Enter and click on Results and Activities from the Menu on the top of the on home screen. 

 

2. The system will take you to a page to select your Data Entry Page. For this demo we are choosing the 

Field Measurements/Observations Data Entry Page. 

 

The data entry page is generated and displayed.   It shows input fields and default values based on the 

associated Data Entry configuration.  The top portion of the page represents one activity.  Each row in 

the bottom portion represents one result associated with the activity. 
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For this demo exercise we’ll create three Field Measurement/Observation activities with associated 

results in the 106Project project using the WQFM collection method based on the following field 

sheet: 

 

Note: Be sure to make the activity ID unique, such as a combination of the location ID, the date, 

the time, and the type of activity.  If you use activity IDs that have been used previously, AWQMS 

and WQX will both assume you wish to update the existing activities with modified information 

and will also delete the existing result records for the existing activities and replace them with the 

new results you are typing in.  In other words, if you don’t use unique activity IDs, you may 

accidentally overwrite existing data with new data! 
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Note that there are three activities, one on each row.  An activity represents a measurement, 

observation, or sample taken at a location on a date at a time (and maybe at a depth).  See the 

AWQMS user guide glossary of terms for more on the definition of an activity.  

 

3. For the first activity, fill in the activity fields with appropriate values.  In some cases, you should be able 

to just leave the defaults.   

4. For the first activity, fill in the results fields with the DO, pH, Air Temp, H2o Temp, and Turbidity values.  

(Leave the result value fields for the other characteristics blank).  

 
5. Click the Add New button.  This will attempt to save your new activity and result and then provide a 

blank form to allow you to add another new activity with associated results. 

In the case of our demo, we see some warnings: 
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These warnings are based on the QA/QC thresholds we created in a previous exercise.  The system has 

saved our records but is warning us that we are entering values for some unexpected parameters.  This 

is a great example of the AWQMS Quality Control thresholds feature doing its job!  In a real world 

scenario like this, you would either want to either add the parameters to your thresholds list or “fix” 

the parameters in your data entry form to match expected parameters in your thresholds list.  For this 

exercise, just close the validation pop up warnings by clicking the X button in the upper right corner. 

6. Click the Add New button again to get a blank form. 

7. Fill in the activity and result value fields for the second activity like you did for Steps 3 & 4. 

8. Click the Add New button. 

 
(You’ll get the error pop-up again.  Just close it and click Add New again). 

The system displays another blank form. 

9. Fill in the activity fields and result values for the third activity.   

10. Click the Save button. 
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(You’ll get the error pop-up again.  Just close it and click the Return button to go back to the “Select 

your data entry page” page). 
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STEP 3: Manage and Analyze Your Data 
Now you could verify that the new activities and results you’ve imported and entered are in the system. 

1. Hover over Review on the navigation bar and click on Activities. 

 
The Activities page will be displayed. 

2. In the Search Criteria tab, make sure your Organization ID is selected.  Make sure the other fields are 

empty. 

 
3. Click the Search button. 

The page will refresh but the Activities tab will be displayed.  All activities in the system will be listed in the 

tab. 
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4. Click on the Aquamarine01-20120620-10:00-F activity link. 

The Activity Detail page will be displayed.  Note that this is one of the activities you just entered via the 

data entry form. 
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5. Scroll to the bottom of the Activity Detail page.  Note that the parameter result values you entered are 

listed. 

 

 
6. Click the Return button to return to the Activities list page. 
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QA/QC your data using reports and graphs 
AWQMS has numerous graphs and reports for analyzing your data for assessment purposes.  But you can also use some 

of those same graphs and reports to help QA/QC data that you have in AWQMS.   These tools are found under Analyze 

in the Navigation Bar.  For example, recall that you can create both Exceedance and Quality Control thresholds in the 

Threshold lookup table.  You can run a line graph that plots result values for a characteristic and visually displays 

whether any values in your data are outside the lower/upper Quality Control threshold range you created in your 

thresholds lookup table.  You could also run the percent exceedance report to show the same thing.  

While using the graphs and reports can be a useful approach to validating your data, the purpose of this guide is to 

provide a brief overview of the process with particular emphasis on getting data into AWQMS and submitting it to the 

EPA’s WQX.  Therefore, no further discussion of using data analysis tools is provided here.  If you’d like to learn more 

about this topic, refer to Appendix B. 

Correct errors in your data 
You can correct errors in your data (if any) in AWQMS.  In this exercise we’ll show the more typical approach to 

navigating to the Result List Detail page and correct an erroneous value. 

An advantage within AWQMS is the ability to manually navigate to a result detail page and modify the result 

manually. 

1. Hover on the Review menu item then Click on Results. 

 
The Results list page will be displayed. 

2. In the Search Criteria tab fill in the search criteria for the result(s) you are looking for.  For this 

example, choose your Organization ID.  Just leave the Activity Type(s) search criteria empty. 
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3. Click the Search button. 

 

The page will refresh with the list of results that match the search criteria showing in the bottom 

portion of the page.  Most column headers in the AWQMS list page function as list sorting mechanisms. 

4. Click on the Characteristic column header link. 

 
 

The page will refresh, but the list will now be sorted by characteristic.  This will help you to find the 

value you wish to fix.  Notice how all the Dissolved Oxygen results are now grouped together. 

5. Drag the scroll bar down until you find the Nitrogen value of 86.0867556 dated 6/18/2008 at 

Emerald03. 

6. Click on the characteristic name for the row (in this case, it is the word Nitrogen). 
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The Result Detail page will be displayed for the Result value we clicked on. 

7. Change the value from 86.0867556  to .867556 

 
8. Click the Save button at the top of the result detail page.  

 

Your change will be saved and the page will refresh.  There will be a notification indicating that your 

change was saved.  
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STEP 4: Export and submit your data to WQX 
Once your data is ready to submit to WQX, AWQMS makes it a simple process. 

What is WQX? 
WQX stands for “Water Quality eXchange”.  WQX is an EPA database and set of related “web services” for consolidating 

surface water quality data via the Internet.  For more information on WQX, see the following web page:  

http://www.epa.gov/storet/wqx. 

The WQX website mentions a tool called “WQX Web”.  Do I need that? 
No.  If you have AWQMS, you do not need to use the EPA’s WQX Web tool for submitting data.  In fact, AWQMS can do 

everything WQX Web can do, and much more. 

Has my organization submitted data to WQX previously from AWQMS? 
How can you tell whether your organization has ever submitted data to WQX through AWQMS?  This is simple. 

1. Hover over the Analyze menu option in the navigation menu and select Reports. 

 
The Data Analysis page will display with the Reports tab selected. 

 
2. Click on the Activity and Result Summary - Recent report icon. 

http://www.epa.gov/storet/wqx
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AWQMS will display a report that lists organizations to which you have access in AWQMS.  For each organization 

the report will show the date of the last time the organization has exported and submitted data to WQX. 

 

Who submits our data to WQX from AWQMS? 
From a technical standpoint, it just has to be an AWQMS user with the administrative privilege for your organization.  

Other than that, this is a policy decision that your program needs to make.  We recommend designating one person in 

your program who is responsible for submitting the data from AWQMS to WQX.  There could also be a “backup” person 

with the administrative privilege in case the primary person is unavailable for an extended period.   

Submitting data to WQX from AWQMS… 
Regardless of whether you’ve submitted data to WQX from AWQMS before, the process is the same. 

 

1. From the Navigation bar hover over Export then click on the Submit data to EPA (and share with the 

public). 

The Export/Submit to EPA page will be displayed. 

2. Fill in the fields on the form.  Choose your 

organization.  Be sure to include all new or 

changed records that have not been submitted to 

WQX.  Choose to include all parameters and 

include all attachments. 

3. Click the Continue button.  

Generally speaking, personnel from the 

AWQMS developer/supporter, Gold 

Systems, Inc. should not submit the data 

for you. 
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A summary of the records that will be included in the WQX Submission File will appear.  

4. Click the OK button. 

 
The Submission File Details form will be displayed.  Fill in or modify the information as you see fit.  

 
For the demo environment, it doesn’t matter what you put for each section but in the production 

environment it of course is important to have accurate contact information. 

5. Select the Export data and make it available to the public radio button. 

6. Click the Continue button. 
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The system will attempt to export your data as a WQX-compatible file and then submit the file to WQX 

via the EPA’s Central data eXchange (CDX).  The Dataset 

Summary page will appear and will auto-refesh every few 

seconds to provide status as to how well the process is working. 

 
 

Once the process has completed, the Dataset Summary page will 

show that the process has completed in the Status field.  In our 

case, the example says Exported XML because we are working in 

our demo environment. 

 
 

To view datasets that have been previously exported: 
1. Hover over Export then click on View datasets that were previously exported. 

 
2. The system will take you to the Datasets (Exported) page, where a list of your recent exports will 

be displayed from all the organizations you have rights to. 

NOTE: If it looks like the process is 

going to take a while, you don’t need 

to stay on this page waiting for the 

process to complete.  In fact, it is best 

if you don’t.  You can continue doing 

work in other parts of AWQMS or you 

can exist AWQMS altogether.  You can 

come back to the Dataset Summary 

page later and check on the progress 

by going to “Review/Update -> My 

Datasets” then clicking on the ID of the 

dataset being exported. 
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Other Sources of Information 
The AWQMS User Guide 

The AWQMS User Guide is a detailed reference manual and is available via a link at the bottom of every AWQMS web 

page.  Additionally, it is available from the AWQMS portal at:  

http://awqms.goldsystems.com/download/AWQMS%20User%20Guide.pdf 

The AWQMS Documentation / Tutorials Web Page 

The AWQMS Documentation / Tutorials Web Page provides a list of web links to general AWQMS Information, AWQMS 

Tutorials, AWQMS release notes, guidance for labs, and template spreadsheets with matching import configurations 

that can be used to import data into AWQMS.  This web page is extremely useful for new AWQMS users.  Available at the 

AWQMS portal at:  http://www.awqms.com/node/2. 

The Region 8 AWQMS Tribal Consortium Web Page 

The Region 8 AWQMS Tribal Consortium Web Page is a “work in progress”.  For members of the Region 8 AWQMS Tribal 

Consortium, it provides a flow chart of the AWQMS support process, a list of available support tools (such as FAQs), a list 

of webinar recordings for those who were not able to participate in the webinars at the time they were conducted, and 

information about how to use the consortium’s email list.  The page is available on the AWQMS portal at:  

http://awqms.com/node/13. 

The EPA’s WQX Web Page 

The EPA’s WQX Web Page provides a useful description of what the Water Quality eXchange is.  The web page is 

available at:  http://www.epa.gov/storet/wqx/. 

Conclusion 
In this tutorial we have discussed the following: 

 Different modes of AWQMS availability: AWQMS-Demo, AWQMS-Cloud, Deployed AWQMS; 

 How to log into AWQMS; 

 An overview of the AWQMS/WQX process; 

 Getting Projects, Monitoring Locations, and other Meta-data into AWQMS; 

 Getting Activities and Results Data into AWQMS; 

 Managing, Quality Checking, and Fixing Data in AWQMS; 

http://awqms.goldsystems.com/download/AWQMS%20User%20Guide.pdf
http://www.awqms.com/node/2
http://awqms.com/node/13
http://www.epa.gov/storet/wqx/
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 Submitting Data from AWQMS to WQX; 

 Where to Find Additional Information about AWQMS. 
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Appendices 
The following appendices contain more information on advanced topics and also reference information. 

Appendix A - If you have a lot of projects that are not yet in AWQMS… 
The tutorial in the Getting Started Guide assumes that you only have a few projects and that you have manually added 

them to AWQMS using the steps above.  However, if you have a lot of projects that are not yet in AWQMS and you feel 

that it would be overly-tedious to manually enter your projects into AWQMS, you could import a text file of project 

records under Import.  This approach may be faster than entering each project manually. 

You would follow almost the exact process as for importing a file of monitoring locations, except that you’d import a file 

of projects.  When you import a file of projects, the imported data becomes an input dataset.  (See AWQMS User Guide 

Section 5. WORKING WITH INPUT DATASETS). 

1. Hover on the Import on the navigation bar and click on Projects.  

 

The Import File page will then be brought up to your screen. 

2. Fill in the form to specify what file to import and how to import it 

A) Choose what import configuration you want to use 

B) What type of file it is you are importing (.txt .xlsx, etc) 

C) Which worksheet you want to import 

D) Choose the radio button that identifies if you are importing new, old, or a combo of projects 

E) Select your file you want to import 
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3. Click the Import Data button to begin importing your file. 

The system will display the Dataset Details page.  The page will tell you that it is importing the file. 

 

If all goes well, the Dataset Details page will refresh and indicate that it has completed importing the file.   

 

4. Click the Migrate button. 

The Dataset Information Page will indicate that the data is being migrated from the AWQMS staging area to the 

AWQMS management area.  NOTE: Migrating in AWQMS is NOT the same as submitting data to WQX! 
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If all goes well, the Dataset Information page will refresh and indicate that the projects migrated successfully.  

5. Click the Return button to return to the Home page. 

 

You could now hover on Metadata and click on the Projects in the navigation menu and search for the new 

projects you imported to verify they are in the system.  
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Project Import Configuration – Do I have one and what should I do if I don’t? 

In the exercise above, we assumed you already have an import configuration for importing your list of projects.  We 

used the import configuration for projects that is built into the demo environment.  If you don’t already have an import 

configuration for importing projects, you can do one of the following to get one: 

1. Ask someone who already has one (such as Gold Systems or a co-worker) to share theirs with you (give you 

rights to view or even edit theirs).  This is, by far, the easiest method!  The AWQMS user guide has instructions 

on how to share an import configuration with someone else.  Just do a search on Rights on an Import 

Configuration in the AWQMS User Guide.  Once you have access to someone else’s import configuration, you 

can just make a copy of theirs and “tweak” it to meet your needs.   Frankly, project import files are typically 

quite simple and it may actually be easier to just modify your file to match whatever import configuration you 

have access to. 

2. Save the demo import configuration from the demo environment as a file and then create a new import 

configuration in your live AWQMS account based on the saved file.  From the Demo environment, you just click 

the Save to File button at the top of the import configuration detail page.  Then in your live account, you create 

a new import configuration by importing a saved file.  (Search for Create an import configuration from a saved 

file in the AWQMS user guide). 

3. Build your own from scratch.  (Search for Creating a New Import Configuration in the AWQMS user guide). 

4. Download the WQX Web template from the EPA WQX Web Downloads web site and import the projects 

template import configuration.  This is not worth explaining in this context; especially when there are much 

easier methods.  However, it is essentially similar in concept to #2, above.  The EPA has created some import 

configurations and saved them as files that you can download and the use as the basis for a new one in AWQMS.  

There are links to the EPA template at the AWQMS portal documentation / tutorials page. 

  

http://www.awqms.com/node/2
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Appendix B – Using the AWQMS Data Analysis Tools as a QA/QC Check 
AWQMS has numerous graphs and reports for analyzing your data for assessment purposes.  But you can also use some 

of those same graphs and reports to help QA/QC (Quality Control) data that you have in AWQMS.   These tools are 

found under Analyze.  For example, recall that you can create both Exceedance and Quality Control thresholds in the 

Threshold lookup table.  You can run a line graph that plots result values for a characteristic and visually displays 

whether any values in your data are outside the lower/upper QA/QC threshold range you created in your thresholds 

lookup table.  You could also run the percent exceedance report to show the same thing.  

Why would I use the AWQMS Data Analysis Tools as a QA/QC Check 

The primary reason to use the AWQMS data analysis tools as a QA/QC Check would be to validate data that was 

imported or entered into AWQMS prior to the implementation of the QA/QC Result Validation Thresholds checking 

capabilities.  It is important to perform such a check and either correct or flag anomalous data prior to submitting it to 

WQX and prior to using the data to make local decisions regarding water quality.  Otherwise, the anomalous values 

might be used inappropriately to make policy decisions at national or local levels. 

How do I establish my QA/QC thresholds in AWQMS? 

See the section above in this document on Adding QA/QC validation thresholds.  Also, see Appendix C – QA/QC 

Threshold Recommendations for Region 8 Tribes below for suggested QA/QC validation threshold values. 

Some Examples 

AWQMS has numerous graphs and reports for analyzing your data for assessment purposes.  But you can also use some 

of those same graphs and reports to help QA/QC data that you have in AWQMS.   This document is focused on data 

input and validation; not assessment.  Therefore, we are only going to talk about the graphs and reports in that context.  

These tools are found under Analyze --> Graphs.  For example, you can run a line graph that plots result values for a 

characteristic and visually displays whether any values in your data are outside the lower/upper QA/QC threshold range 

you created in your thresholds lookup table.  You could also run the exceedance report for results using QA/QC 

thresholds to show the same thing.  

Using the line graph 

1. Hover on the Analyze on the navigation bar, a drop down menu will display. 

2. Click on the drop down Graphs. 

 

The Data Analysis page will be displayed. 
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3. Click on the type of Graph you would like to view your data, Multi-Parameter Line Graph 

 
The search criteria page for the Multiple Parameter Line Graph will be displayed.  

 

4. Click on the Other Search Criteria Tab and change the date range to cover all of 2008. 

 
 

5. Click the Result Status and select the results to be graphed. 

6. Select the Media you want to display on your graph. 

7. Click on the Locations Search Criteria tab: 

 

8. Select your Monitoring Location using the Magnifying Glass/Search Button and select your location from the 

search page. 
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The search criteria page for the Multiple Characteristic Line Graph will again be displayed and will show the 

Emerald River location as selected. 

9. Select the Parameters Tab and click Refresh Parameter List. 

 

The page will refresh and show the various analytes for which the location actually has result values in the 

system. The Threshold Group drop-down list will become visible. 

 
There are two types of threshold groups: Quality Control and Exceedance.  Quality Control-type thresholds are 

for making sure you don’t have data unexpected/invalid values in your data. Exceedance-type thresholds are for 

figuring out if the water quality at a site is bad.  Typically, Quality Control-type thresholds cover a wider range 

than Exceedance-type thresholds.  The Threshold Group drop-down list allows you to select several types of 

Quality Control or Exceedance thresholds.  In this demonstration, however, we have only set up the Quality 

Control thresholds. 

10. Select the Quality Control thresholds from the Threshold Group drop down list. 

11. Check the box next to Dissolved oxygen (DO). And check the box next to Water Temperature  

12. Click Create Graph at the top to generate the graph. 
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The graph will be displayed in a separate window.  Notice how there is a correlation when the water temperature 

rises the Dissolved oxygen goes down. 

Using the Report 

We will use the same search criteria for running the Result Exceedance Report 

that we used for the Multiple Characteristic Line Graph. 

1. Hover over Analyze on the menu bar and click Reports. 

 

2. Select the Result Exceedance Report from the report menu, a click Current Search Criteria. 
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The Exceedance Report for Result page will be displayed. 

3. Confirm that your current search criteria continued to the Report and then click on Create Report 

4. The report is generated and displayed.  Any values that are outside the lower and upper thresholds are 

annotated as exceedances. 

Click on the Yes (exceedance) link for the 6/18/2008 value. 

 

The Result Detail page is displayed for the result value that was an exceedance.  You can use this page to 

investigate and learn more about this exceedance value.  If you find that the value is in error (such as a typo), 
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you could fix the error in the Result Detail page and click the Save button.  For this demo, though, we will leave 

the value as-is and return to our report. 

Appendix C – QA/QC Threshold Recommendations for Region 8 Tribes 
The QC values presented below can reflect true values observed at a site. Therefore, if AWQMS reports indicate that 
these values are exceeded, it is important to closely review the data using the following steps before deciding on a 
corrective action: 

a) Review the lab sheets/data to ensure the data were entered correctly. 
b) For field parameters, review the original field sheet and check for data entry errors. 
c) Review the calibration log to see if meters were properly calibrated. If meters are not properly calibrated on 

a regular basis, it is not uncommon to have record odd/ inaccurate result values.  
d) Review any blank and duplicate data collected at the site. 

Corrective Actions: 

 If data were incorrectly entered into AWQMS, enter the correct value. 

 If meters were not properly calibrated, we recommend flagging the data as “Validated”, meaning “Reported 
result has been verified and reviewed”) [Choices are: “Accepted”, “Final”, “Preliminary”, “Rejected”, or 
“Validated”]. 

 If the result appears to be valid, it may suggest a water quality concern.  We suggest revisiting the site as soon as 
possible to obtain additional data. 

Validation Values:  

Nutrients:  The list below is not intended as a recommended suite for nutrients. Please refer to EPA’s document 
(Nutrient Characteristic List) for recommendations. In general, we suggest collecting TN and TP unless there is a specific 
point source concern: 

 Total Nitrogen:  Likely to see a lot of Nondetect values; important to enter the detection limit. Upper QC value –  
5 mg/L  

 Ammonia: Likely to see a lot of Nondetect values; important to enter the detection limit.  
o Upper value of 2 mg/L.  

 Total Phosphorus: Likely to see a lot of Nondetect values; important to enter the detection limit. 
o Upper Value of 1 mg/L? 

 Phosphate: Likely to see a lot of Nondetect values; important to enter the detection limit.  
o Upper value of  1 mg/L 

Metals: Similar to nutrient, nondetect results are common for metals.  It is important to enter the detection limit.  It all 
depends on land use, geology, historic mining, etc.  One suggestion is to only use ALC for screening.   Another suggestion 
is to pull together human health values which tend to be much greater than the ALC. 

Field Parameters: 

Validation Values Lower QC Value Upper QC Value 

Total Nitrogen mg/L None 4  

Ammonia mg/L None 2 

Total Phosphorus mg/L None 1 

Phosphate mg/L None 1 

Metals TBD TBD 

Temperature Deg C 1 35 

pH 4 11 

Dissolved Oxygen mg/L 1 14 



AWQMS – Getting Started Guide 

69 
 

Dissolved Oxygen Percent Saturation 10 200 

Turbidity NTU None 300 

Appendix D – QA/QC Activities and Results (Duplicates and Blanks) 

Recommendations for labeling QC samples and recording QC samples on field and lab forms. 

The EPA provides a web page on “Quality Assurance, Quality Control, and Quality Assessment Measures” at: 

http://water.epa.gov/type/rsl/monitoring/132.cfm. 

QA/QC Activity and Result Data in WQX and AWQMS 

Every activity in WQX and AWQMS must have an activity type.  QA/QC duplicate and blank samples should not be 

included as normal activities, such as “Field Msr/Obs” or “Sample-Routine”.  They should, instead, be included using the 

special QA/QC activity types defined in the Activity Type lookup tables.  This approach will allow you to filter them out, if 

desired, when analyzing/reporting on the data.  The list of allowed activity types is: 

Code Description 

Analytical 
Method 
Required 

Monitoring 
Location 
Required 

Field Msr/Obs 

MEASUREMENTS involve something measured in its 
environmental setting usually using some type of equipment.  
OBSERVATIONS are made by people, usually without the use 
of equipment, and are frequently qualitative. N Y 

Field Msr/Obs-
Habitat Assessment 

A field activity conducted to evaluate a habitat, according to 
an organizations pre-defined habitat assessment scheme. N Y 

Field Msr/Obs-
Portable Data 
Logger 

Measurements made in the field by an automated data logging 
device, running unattended and producing a suite of data 
values at repeating intervals set by its owner/operator. N Y 

Quality Control 
Alternative 
Measurement 
Sensitivity 

A repeated measurement of the same field (also a lab where 
detection limits do not apply) sample collected to control 
sensitivity typically for a specific instrument in order calculate 
the alternative measurement sensitivity (AMS). AMS is the 
standard deviation of 7 measurements of a sample (with a 
signal in the quantitative range) times the two-sided critical t-
value for 99% confidence (3.708) Y N 

Quality Control 
Alternative 
Measurement 
Sensitivity Plus 

A repeated measurement of different field samples collected 
to control sensitivity typically for a specific instrument/sensor 
in order calculate the alternative measurement sensitivity 
(AMS+).  AMS+ is defined as the standard deviation of 7 
measurements of samples collected very closely in time and 
space times the two-sided critical t-value for 99% confidence. Y N 

Quality Control Field 
Calibration Check 

A standard independently prepared (different source, different 
analyst) from the calibration standards and run after the 
original calibration to verify the original calibration.  There is 
usually one calibration check standard per batch. N N 

http://water.epa.gov/type/rsl/monitoring/132.cfm
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Code Description 

Analytical 
Method 
Required 

Monitoring 
Location 
Required 

Quality Control Field 
Replicate Habitat 
Assessment 

A habitat measurement or evaluation collected to assess the 
reproducibility of the sampling technique. N Y 

Quality Control Field 
Replicate Msr/Obs 

A field measurement or observation taken to assess the 
reproducity of the sampling technique or analytical method. N Y 

Quality Control Field 
Replicate Portable 
Data Logger 

A measurement taken to verify the quality of data taken by a 
data logger. N Y 

Quality Control Field 
Sample Equipment 
Rinsate Blank 

A sample of analyte-free media that has been used to rinse the 
sampling equipment. It is collected after completion of 
decontamination and prior to sampling. This blank is useful in 
documenting adequate decontamination of sampling 
equipment. N N 

Quality Control 
Sample-Blind 
Duplicate 

The duplicate samples are identical samples (collected from 
same source and same time) however blind duplicates are 
submitted to the laboratory by an identification scheme so 
that the laboratory does not know the samples are identical.   
The purpose of blind duplicates is to test for laboratory bias.   Y Y 

Quality Control 
Sample-Equipment 
Blank 

A sample of analyte free water analyzed with field samples to 
assess the presence or absence of equipment or instrument 
contamination. Y N 

Quality Control 
Sample-Field 
Ambient Conditions 
Blank 

The analyte free media is tested to assure the preciseness of 
ambient conditions. It helps in controlling the effects of 
environment on the sample. Y Y 

Quality Control 
Sample-Field Blank 

A sample of analyte free water poured into a sample container 
in the field, preserved and shipped to the laboratory with field 
samples.  The purpose of a field blank is to assess 
contamination from field conditions during sampling. Y N 

Quality Control 
Sample-Field 
Replicate 

Multiple samples taken within each combination of time, 
location, and any other controlled variables. The purpose of 
collecting replicate samples is to obtain precision. For a large 
size field it is important to break field into homogeneous sub-
areas and collect samples proportions to the size of each sub-
area. Y Y 

Quality Control 
Sample-Field Spike 

A known mass of target analyte added to a blank sample or 
subsample in the field. The pupose of a field spike is to show 
that sample preperation procedures do not contribute to loss 
of analytes. Y Y 

Quality Control 
Sample-Field 
Surrogate Spike 

A pure substance with properties that mimic the analyte of 
interest is called surrogate. Target Surrogate is added in 
sample to determine the recovery efficiency for quality control 
purposes. Y Y 
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Code Description 

Analytical 
Method 
Required 

Monitoring 
Location 
Required 

Quality Control 
Sample-Inter-lab 
Split 

Split samples are obtained by dividing one sample into two or 
more identical sub-samples, and analyzed at different 
laboratories.  Interlaboraory splits are used to compare the 
accuracy and precision of the laboratories doing the analyses. Y Y 

Quality Control 
Sample-Lab Blank 

Lab Blanks are analyte-free matrices prepared in the lab and 
analyzed with samples to identify potential lab sources of 
contamination. Y N 

Quality Control 
Sample-Lab Control 
Sample/Blank Spike 

In the lab deionized water is spiked with all the analytes in 
concentrations close to those in the field samples, prepared as 
a sample, and run/re-run on a set frequency. N N 

Quality Control 
Sample-Lab Control 
Sample/Blank Spike 
Duplicate 

In the lab deionized water is spiked with all the analytes in 
concentrations close to those in the field samples, prepared as 
a sample, and run/re-run on a set frequency. N N 

Quality Control 
Sample-Lab 
Duplicate 

One of two samples taken from the same population and 
carried through all steps of the sampling and analytical 
procedures in an identical manner. Duplicate samples are used 
to assess variance of the total method including sampling and 
analysis. Y N 

Quality Control 
Sample-Lab Matrix 
Spike 

An aliquot of an environmental sample to which known 
quantities of analytes are added in the laboratory.  The matrix 
spike is analyzed in an identical manner as the sample. Y N 

Quality Control 
Sample-Lab Matrix 
Spike Duplicate 

An aliquot of an environmental sample to which known 
quantities of analytes are added in the laboratory.  The matrix 
spike is analyzed in an identical manner as the sample. N N 

Quality Control 
Sample-Lab Re-
Analysis A sample that is analyzed more than once. Y N 

Quality Control 
Sample-Lab Spike 

A known mass of target analyte added to a blank sample or 
subsample in the laboratory. The pupose of a laboratory spike 
is to show that sample preperation procedures do not 
contribute to loss of analytes. Y N 

Quality Control 
Sample-Lab Spike of 
a Lab Blank 

The lab blank (method blank) is prepared in the lab to 
represent the matrix as closely as possible, then spiked with 
known concentrations of the analytes. N N 

Quality Control 
Sample-Lab Split 

A sample split in the laboratory from half of a mother or 
parent sample. Y N 

Quality Control 
Sample-
Measurement 
Precision Sample 

A sample (i.e., test sample or control sample/standard) used 
either singly or in replicate, as appropriate, to monitor the 
precision of method. Y N 

Quality Control 
Sample-Other 

This category contains quality control measures of any other 
process to which a sample is subjected, and not included in 
this list. Y N 
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Code Description 

Analytical 
Method 
Required 

Monitoring 
Location 
Required 

Quality Control 
Sample-Post-
preservative Blank 

The analyte-free media which has undergone the same 
preserving process as the samples. This Blank is tested to 
check the quality of the preservation process. Y N 

Quality Control 
Sample-Pre-
preservative Blank 

The analyte-free media tested before undergoing the same 
preserving process as the samples. This Blank is tested to 
check the quality of preservation process. Y N 

Quality Control 
Sample-Reagent 
Blank 

Reagent Blank is analyte free water analyzed with samples, 
one per sample test. The reagent blank is analyzed to control 
the quality.  Y N 

Quality Control 
Sample-Reference 
Sample 

A sample (i.e., test sample or control sample/standard) with 
known analyte concentration used either singly or in replicate, 
as appropriate, to monitor method performance 
characteristics.  Y N 

Quality Control 
Sample-Trip Blank 

Trip blanks are test samples of analyte-free media taken from 
the laboratory to the sampling site and returned to the 
laboratory unopened. They are used to measure cross-
contamination from the container and preservative during 
transport, field handling, and storage. Usually, at least one trip 
blank should be prepared for each sample type per trip. Y N 

Quality Control-
Negative Control 

The process to control the quality of measurement with 
absence of analyte or habitat is negative control. Y N 

Sample-Composite 
With Parents 

A sample split in the laboratory from half of a mother or 
parent sample. Y N 

Sample-Composite 
Without Parents 

Describes a sample which is a composite of either several 
discrete sampling events not described elsewhere, or is a 
sample collected by a continuous process over some time 
period. No database record exists as its parent. Y Y 

Sample-Depletion 
Replicate 

Lab Blanks are analyte-free matrices prepared in the lab and 
analyzed with samples to identify potential lab sources of 
contamination. N Y 

Sample-Field Split 
A sample created in the field from half of a mother or parent 
sample. Y Y 

Sample-Field 
Subsample 

A sample created in the field from a portion of a mother or 
parent sample Y N 

Sample-Integrated 
Cross-Sectional 
Profile 

A discrete/integrated sample, usually derived from a 
continuous record, representing cross-section of the stream. Y Y 

Sample-Integrated 
Flow Proportioned 

A sample integrated over an interval or space within which 
changes in flow are used to alter the proportion of the 
sampled medium contributing to the integrated sample. Y Y 

Sample-Integrated 
Horizontal Profile 

A sample integrated over an interval or space within which 
changes in flow are used to alter the proportion of the 
sampled medium contributing to the integrated sample. Y Y 
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Code Description 

Analytical 
Method 
Required 

Monitoring 
Location 
Required 

Sample-Integrated 
Time Series 

A discrete/integrated sample, usually derived from a 
continuous record, representing some portion or segment of 
elapsed time within the overall activity duration or sample 
period. Y Y 

Sample-Integrated 
Vertical Profile 

A discrete/integrated sample, usually derived from a 
continuous record, representing some portion or segment of a 
vertical track within the study area. Y Y 

Sample-Negative 
Control A controlled sample with absence of analyte. Y Y 

Sample-Other 
This category contains a sample collected following a process 
which is not included in this list. Y Y 

Sample-Positive 
Control A controlled sample with presence of analyte. Y Y 

Sample-Routine 

A sample gathered using straightforward grab procedures for 
purposes of a general evaluation of the environment at the 
site. Y Y 

 

Note that using a different activity type for the QA/QC samples inherently forces you to have a separate activity for the 

QA/QC samples than for the routine ones.  It follows, then, that the activity ID for the QA/QC samples has to be different 

than for the normal samples because every activity in the system must have a unique ID.  For example, let’s say you have 

a routine water chemistry sample that was taken at Monitoring Location A on April 1, 2014 at 1:21:33PM and an 

associated QA/QC duplicate taken at the same place on the same date at the same time.  The routine sample might have 

an activity ID of “MonLocA-20140401-01:21:23-WC-SR” (for “Sample-Routine”-type); and the duplicate might have an 

activity ID of “MonLocA-20140401-01:21:23-WC-QCSFR” (for “Quality Control Sample-Field Replicate”-type).  If you tried 

to give them both the same ID, the system would either error or replace whichever activity was entered first with 

whichever was entered last, depending on exactly what you are doing at the time. 


